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Implementing Red Hat Linux 6.1
on Compaq ProLiant Servers
Abstract:  This document provides information on installing and
implementing a Red Hat Linux 6.1 operating system on a Compaq
ProLiant server for field service engineers and system administrators.
It includes a list of certified Compaq hardware, a description of
operating system requirements, a step-by-step installation, and a
troubleshooting section.

Appendices A and B include data on standard specifications for
Compaq ProLiant products. Appendix C describes the SoftPaqs
Compaq released for Red Hat Linux 6.1. Appendix D provides
website addresses for additional information on Compaq and Red
Hat Linux.

For additional information regarding the configuration of Linux on
Compaq X86 servers, see the white paper entitled Installation and
Configuration Guide for Linux and Apache Web Server on Intel.
Check our website at http://www.compaq.com/linux or test drive
Linux at http://www.testdrive.compaq.com/linux.

Note:  We suggest you read and thoroughly understand this
document before installing Red Hat Linux 6.1 on your Compaq
server.

http://www.compaq.com/linux
http://www.testdrive.compaq.com/linux
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Hardware
Compaq participates in the Red Hat Linux Hardware Certification Program and Compaq
engineers constantly review the Compaq hardware and drivers to ensure compatibility with
Linux. Check the Compaq website: http://www.compaq.com/linux for the latest information
regarding hardware compatibility and device driver updates.

Compaq engineers installed and tested Red Hat Linux 6.1 with several different configurations of
Compaq ProLiant servers.  Because of its architecture, some exceptions exist for the ProLiant
8000 and for SMART Array Controllers. Special instructions for the ProLiant 8000 and SMART
Array Controllers appear next to the symbol shown below.

Servers
The following Compaq servers were certified for use with Red Hat Linux 6.1 as of the date of
publication of this document.

� ProLiant 400

� ProLiant 800

� ProLiant 1600R

� ProLiant 1850R

� ProLiant 3000

� ProLiant 5500

� ProLiant 6400R

� ProLiant 6500

� ProLiant 7000

� ProLiant 8000

� ProLiant 8500

� Prosignia Server 720

� Prosignia Server 740

Other servers in the Compaq ProLiant and Prosignia families are being tested for certification
with Red Hat Linux at this time.

ProLiant
8000

http://www.compaq.com/linux
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Controllers
All servers tested, with the exception of the ProLiant 8000 and ProLiant 8500 servers, come
equipped with a Symbios Logic SCSI controller. The Compaq SMART Array controller ships
standard on the ProLiant 8000 and ProLiant 8500; it is available as an option on other ProLiant
servers.

The Compaq SMART Array controller device driver can be obtained through our website on a
SoftPaq; use SoftPaq 10775 for DOS or SoftPaq 10776 for UNIX. See Appendix C for more
information on the SoftPaqs. The device driver works with the following controllers.

� Compaq Integrated SMART Array Controller

� Compaq SMART Controller (EISA)

� Compaq SMART-2/E Array Controller (EISA}

� Compaq SMART-2/P Array Controller

� Compaq SMART-2DH Array Controller

� Compaq SMART-2SL Array Controller

� Compaq Smart Array 221 Controller

� Compaq Smart Array 3100ES Controller

� Compaq Smart Array 3200 Controller

� Compaq Smart Array 4200 Controller

� Compaq Smart Array 4250ES Controller

Tape Devices
The following Compaq tape drive families work with Red Hat Linux:

� DAT

� SLR

� DLT

� AIT

Network Interface Controllers
Both the ThunderLAN and Intel chipset network interface controllers (NICs) operate in Linux. If
you do not know what type of NIC you have on your equipment, refer to Appendix A for
hardware specifications. The following controllers are based on the ThunderLAN chipset:

•  Compaq NetFlex-3/P Controller

•  Compaq Integrated UTP/BNC Controller

•  Compaq Integrated 10/100 TX UTP Controller

•  Compaq Dual 10/100 TX UTP Controller

•  Compaq Netelligent 10/100 TX PCI UTP Controller

http://www.compaq.com/support/files/10501.html
http://www.compaq.com/support/files/10501.html
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The following controllers are Intel based NICs:

•  Compaq NC3122 Fast Ethernet NIC

•  Netelligent 10/100 TX WOL PCI UTP Intel Controller

Obtain the driver for the Intel 6120 Series NIC, the gigabit module, through the Intel website:
http://www.intel.com/support/network/adapter/1000/software.htm. The Compaq NC3151
Controller uses the gigabit module and requires this driver to operate in a Linux environment.

The Compaq NC3131 DualPort Controller requires the device driver found on SoftPaq 10775 (for
DOS) or SoftPaq 10776 (for UNIX).

The 2.2 kernel can only detect devices on the Primary PCI Bus, PCI bus 0. By default,
the NIC on the ProLiant 8000 and ProLiant 8500 servers is not located on PCI bus 0.
Move the NIC to a slot located on PCI bus 0 before beginning installation.

Requirements
To use Red Hat Linux 6.1 as your server operating system, your server should meet the system
requirements in Table 1.
Table 1.  System requirements

Component Requirement

Processor Pentium or higher

RAM 64 MB

Hard drive 1.6 GB

These requirements pertain to the operating system only and do not include consideration for any
software applications loaded on your server. Please check your application requirements to make
certain your system can run both the operating system and your software.

Installation
Compaq developed a SoftPaq to address issues with Red Hat Linux 6.1 installation and the Smart
Array Controllers and the Compaq NC3131 DualPort NIC. The SoftPaq is available in DOS
(SP10775), and UNIX (SP10776) versions. Download the SoftPaq from
http://www.compaq.com/support/files/server/us/index.html and follow the instructions provided.
See Appendix C for more information regarding these SoftPaqs. Check our website for the latest
information on device drivers.

In order to properly install the Red Hat Linux 6.1 operating system, use SmartStart to format your
hard drive and install Compaq utilities. The Red Hat Linux 6.1 software provides additional
formatting parameters for partitioning the hard drive, configuring the server for installation,
selecting the packages to install, and configuring your monitor.

ProLiant
8000

http://www.intel.com/support/network/adapter/1000/software.htm
http://www.compaq.com/support/files/server/us/index.html
http://www.compaq.com/support/files/server/us/index.html
http://www.compaq.com/support/files/server/us/index.html
http://www.compaq.com/support/files/server/us/index.html
http://www.compaq.com/support/files/server/us/index.html
http://www.compaq.com/linux
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Formatting your Compaq Hardware
Both the Compaq SmartStart and Support Software CD and the Red Hat Linux software are
necessary to format your Compaq hardware to install the operating system properly.

Compaq SmartStart and Support Software CD

To begin the installation, boot the server with the Compaq SmartStart and Support Software CD.

•  Select Manual Configuration → SCO → UnixWare 2.1.3.

SmartStart verifies the configuration, configures the hardware, loads the configuration to the
partition, and then restarts the system twice.

If you have SMART controllers on your server, SmartStart automatically goes to the Array
Configuration Utility. Use the instructions available on SmartStart and the Help file to configure
your array. After you complete the configuration, close the window to restart the server. If you
have SMART controllers on your system, please see �SMART Array Controllers� under
�Troubleshooting.�

For systems without SMART controllers, SmartStart detects and sets the integrated controller as
the primary controller and installs the system partition.

SmartStart formats a temporary partition, restarts the server, decompresses SmartStart files, and
discovers the hardware. After this process completes, SmartStart notifies you of the removal of
SmartStart from memory and the server restarts. The message on the next screen instructs you to
remove the SmartStart CD, put in the operating system CD, and click Continue. Before you click
Continue, understand the installation options for Red Hat Linux 6.1.

Red Hat Linux 6.1 Software

There are four options for installing Red Hat Linux 6.1:

� Red Hat Linux CDROM

� Red Hat Linux boot diskette and CDROM

� Red Hat Linux boot diskette and hard drive

� Network

The Red Hat boot diskette allows for installation from the CDROM or the hard drive. The
network installation offers HTTP, NFS, and FTP options.

You must run fdisk to maintain your Compaq utilities. If you use the Red Hat boot diskette, it
offers the option of running fdisk through the Regular Mode for installation. If you boot from the
Red Hat CDROM or a network boot diskette, use Expert Mode for installation to maintain your
system partition.

The procedure listed below includes the additional procedures required in Expert Mode. Some of
these instructions occur automatically in Regular Mode. Installation through a network
connection contains the same procedures but in a different order. Basic responses do not change
regardless of the method except as indicated in the text.

The system comes up to the Red Hat Install screen and contains a message regarding the type of
installation you want to perform.
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•  Enable Expert Mode, unless you use the Red Hat boot diskette, by typing expert and
pressing the Enter key.

A screen prompting you to insert the driver disk appears.

•  Highlight Cancel → Enter.

•  Highlight Language → Enter.

•  Highlight Keyboard Type → Enter.

•  Highlight Install Method → Enter.

The next screen prompts you to select how the operating system will be loaded.

•  Select the appropriate method.

This screen does not appear when using the CD only installation. The next screen message
concerns loading special devices.

•  Highlight Add Device → SCSI → Enter.

•  Scroll down and select Compaq SMART/2 RAID Controller if you
have array controllers.

•  Scroll down and select Symbios/NCR 53C8xx if you have an
embedded controller.

Note:  If you make a mistake on the devices, restart the installation. The incorrect driver might
become part of the boot sequence. If it does, the boot sequence might look for the wrong
hardware and could give a Kernel Panic message on restart.

The controller loads and a message on the screen verifies that it found the driver and provides an
option to select another device.

•  Highlight Add → Network → Enter.

•  Highlight your NIC from the list → Enter.

The next screen message verifies that it found the driver and lists all drivers loaded.

Red Hat then looks for your mouse driver and defaults to the 3 Button Mouse selection. Red Hat
recommends enabling the three-button mouse emulation for your two-button mouse because its
GUI makes use of the third button.

•  Go to Generic → 2 Button Mouse (PS/2) → Select Emulate 3 Button Mouse → Next.

Note:  To emulate the third button on a two-button mouse, press both the right and left buttons
simultaneously.

The System Installer screen appears prompting you to partition your hard drive.

Lists provided throughout the
installation process are not
necessarily alphabetical.
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Partitioning your Hard Drive(s)
While each physical hard drive in your server can contain only four primary partitions, you can
create multiple extended partitions. Decide how you want to partition your hard drive before you
start this process. The partition set up by SmartStart contains Compaq Utilities and Diagnostics.
To operate Red Hat Linux, you need a Linux Native partition and a Linux Swap partition. You
might want a separate boot partition. For large logical drives, the boot partition could be
necessary to meet the limitation of installing the boot sequence below cylinder 1024.

Some Red Hat Linux file systems can have their own partitions; they include the following:

� /tmp

� /boot

� /usr

� /usr/local

� /var

� /home

� /opt

Some directories must be a part of /; they include these systems:

� /etc

� /lib

� /bin

� /sbin

� /dev

An extended partition can be created for the partitions needed by Linux. The extended partition
can then be divided into other extended partitions and logical drives depending on how you want
to use the system. If you create an extended partition for the Linux operating system, you still
have one primary partition to set up dual booting. For more information on partitioning your hard
drive, check http://www.redhat.com/support/docs/howto or review the Red Hat documentation.

Determine how you want to partition your hard drive(s) and
calculate your partition sizes before beginning this process. The
Compaq Utilities and Diagnostics partition uses at least five
cylinders. The swap partition, at a minimum, should equal the
RAM in your server and, at a maximum, 2 GB. You can create

up to eight swap partitions, but the size cannot exceed 4 GB total. The boot partition, if you want
one, should require no more than 20 MB. The Linux Native partition can utilize the remainder of
the hard drive space. An option to allow the Linux Native partition to grow is available. If you
create an extended partition for the Linux Native and Linux Swap partitions, the extended
partition can use the remainder of the drive space.

At the System Installer screen,

•  Click Next when you are ready to continue.

The following screen provides several options for the installation type.

Check the options on each installation screen
carefully. Selection of an option makes the
square or diamond look indented.

http://www.redhat.com/support/docs/howto
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•  Select Custom to preserve your Compaq utility partition.

IMPORTANT:  You must run fdisk to properly install Red Hat Linux on your Compaq system
with the CDROM or network boot installation.

•  Select Run fdisk in the upper right hand corner → Next.

•  Select the drive on which to run fdisk.

The screen displays all the hard drives on the server.
Drive codes are simple�sda means the first SCSI disk
and sdb means the second SCSI disk with the
integrated controller. With the SMART Array
controller, Linux labels the hard drive ida/c0d0 with c
being the controller number and d being the disk
number; the first controller and disk numbers are 0.

•  Select the first drive listed → Next.

If Linux sees more than one disk drive, you should either receive the following warning message
at this point of the installation or after you partition the first hard drive:

The partition table on device sdb is corrupted.

To create new partitions it must be initialized,

causing the loss of ALL DATA on this drive.

If you have two disk drives and do not receive this warning message, the second drive might
contain data. In our testing, the only time this message did not pop up, the second hard drive had
not been properly erased.

•  Select Initialize.

The following screen provides a command line so that you can set up your hard drive partitions in
Expert Mode. In Regular Mode, a GUI replaces this screen. Navigate in the GUI to set up your
partitions. In order to create a boot partition in Regular Mode, create a second Linux Native
Partition.

With a SMART Array controller and a large logical drive, you will receive the following
message:

The number of cylinders for this disk is set to xxxx, there is nothing wrong

with that, but this is larger than 1024, and could in certain setups cause

problems with:

1. software that runs at boot time (e.g. LILO)

2. booting and partitioning software from other OSs (e.g. DOS fdisk, OS/2 fdisk)

This warning message reminds you that your boot partition must be under cylinder 1023
or your system will not restart properly after installation.

Command Line Help can be accessed by typing h or m at the command line and pressing Enter.
The Help file provides a list of commands.

IMPORTANT:  The commands on this screen are case sensitive. Check the examples provided
in the documentation if you have problems.

The numbering for disks and partitions using the
SMART Array controllers is as follows:

c=controller followed by the number of the
controller

d=disk followed by the number of the disk

p=partition followed by the number of the partition

ProLiant
8000
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•  Type p (to print the current configuration to the screen).

The Compaq partition, c0d0p3, is the third partition in Red Hat Linux. Because the boot partition
must be assigned to cylinders below 1023, create the boot partition first.

•  Type n (to add a new partition) → p (for primary) → 1 or 2 or 4.

•  Use the default for the first available cylinder.

You have options for determining the size of each partition. You can type the size in cylinders,
the size in megabytes, or the size in kilobytes. Information on the command screen indicates how
to make your choice.

•  Type the appropriate number for your boot partition (20 MB or less).

Create the Linux Native partition in much the same manner as the boot partition.

•  Type n →  p → 1 or 2 or 4.

•  Use the default for the first available cylinder.

•  Type the size you want for your Linux Native partition.

Creating a Linux Swap partition requires a few more keystrokes.

•  Type n →  p → 1 or 2 or 4.

•  Use the default for the first available cylinder.

•  Type the size you want for your Linux Swap partition.

•  Type t (to change the identification for the partition).

•  Type 82 as the hex code.

Either the Linux Native Partition or the boot partition can be configured as the bootable partition
by completing the following:

•  Type a (to make a bootable partition).

•  Type the partition number from which you want to boot.

•  Type p (to check your entry).

You should see the Boot Flag enabled for the appropriate partition.

•  Type w at the command line to complete the formatting and write the table to the disk.

Configuring your Server
After the partition information writes to the disk, Linux exits from the partition section of the
installation and takes you to Disk Druid. Disk Druid assists you in configuring your server by
displaying the partitions created and allowing you to edit them.

•  Highlight the Linux Native partition → Edit.

•  Type / as the mount point to create the root.

If you created a boot partition, set it up as follows.

•  Highlight the boot partition → Edit.

•  Type /boot as the mount point → Continue.

Hex codes can be found by entering
l at the command line.
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The following screen provides an opportunity to select which partition to format.

•  Select the primary drive → Next.

The next screen configures the Linux Loader (LILO); it starts the operating system when the
server boots. You can install LILO to the boot partition, the master partition, or a separate boot
disk.

IMPORTANT:  If you install LILO to the master boot record, you cannot access the Compaq
system partition with the F10 key. Install LILO to the first sector of the boot partition or to the
Linux Native partition.

•  Select the first sector of the boot partition → Next.

The option for linear mode on this page is not required for Compaq X86 server hard drives.

The installation program then goes to the network configuration including:

•  IP Address

•  Netmask

•  Network

•  Broadcast

•  Host name

•  Gateway

•  Primary DNS

•  Secondary DNS

•  Tertiary DNS

Note:  On our CDROM, tertiary was misspelled as ternary but it worked as tertiary.

•  Complete the blanks with the correct information → Next.

The next screen concerns Time Zone Selection.

•  Select your continent → appropriate region → Next.

The following screen allows you to configure your user accounts.

•  Type the Root Password.

•  Confirm the Root Password.

The bottom part of the screen provides an opportunity to add users.

•  Type the User Account Name → Password → Full Name → Add.

Repeat this step for each user you want to add. The user adds to the lower screen and the upper
user screen is blank for the next entry. When completed,

•  Select Next.

The Authentication Configuration screen enables different types and levels of password
protection. Read the documentation and online Help file for more information.

•  Select your desired options → Next.
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Completing the Installation
The last part of the installation process includes selecting the packages you want to install and
configuring your monitor.

After the Authentication Configuration screen, the Package Group
Selection screen displays. Read your Red Hat Linux
documentation to determine what packages you want to install.

•  Select the packages you want to install → Next.

The next screen, the X Configuration screen, configures the video for your monitor. The selection
list includes some Compaq monitors, but not all Compaq monitors. This screen allows you to
manually configure your monitor and to test different configurations. The Generic Monitor can be
used with Compaq SVGA monitors.

•  Select Customize X to manually configure your monitor settings.

Appendix B provides detailed information if you want to manually configure your monitor.

•  Select Use Graphical Login if you want to bring up the GUI on reboot.

After completing the X Configuration screen, a warning screen displays to let you know that Red
Hat Linux is ready to install. It provides the location for the installation log, /tmp/install.log.

•  Select Next.

The screen displays the message: Installing Packages. If you chose
Everything, it takes from 10 to 30 minutes to load the files depending on the
speed of your processor.

The following screen prompts you with an option to create a boot disk.

The next screen message is �Congratulations, take out the media, and reboot.�

Go for it!

Before rebooting the ProLiant 8000, insert the diskette with the file CPQ_RH_INSTALL.IMG
from the SoftPaq in the floppy drive. See Appendix C for information about SoftPaq 10775
and SoftPaq 10776.

•  Restart the server.

•  Type root → Enter →  <root password> → Enter.

Mount the floppy and run the kernel installation script as follows:

     # mount /dev/fd0 / mnt

     # cd /mnt

     # ./install-kernel

     # cd

     # umount /mnt

To bring up the GUI:

•  Type startx → Enter.

Check your Red Hat Linux documentation for information on configuring the desktop.

TIPS: The packages are not alphabetical.
There’s an Everything at the bottom of the
selection list.

This part is not interactive, so take
a well-deserved break.

ProLiant
8000

http://www.compaq.com/support/files/server/us/index.html
http://www.compaq.com/support/files/server/us/index.html
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Troubleshooting
The hardware information in Appendices A and B provide information to properly install and set
up Red Hat Linux. Appendix C supplies data on the SoftPaqs developed by Compaq to address
SMART Array Controllers and the Compaq NC3131 DualPort NIC. Check Appendix D for
website support for Red Hat Linux 6.1 and Compaq servers.

Red Hat Linux stores the installation log at /tmp/install.log. Refer to the log when determining
what steps were completed when installing the operating system.

Basic Troubleshooting Strategy
This section lists basic methodology to use when troubleshooting. First, gather the information to
resolve the issue. In doing so, ask the following questions:

•  Is the problem reproducible or random?

•  What hardware and/or software are involved?

•  Were any errors made in implementing steps?

•  Was more than one variable changed at a time?

•  Does the problem occur on the server or is it specific to a client?

•  Were any steps skipped or completed out of order?

•  Were any steps accidentally added?

•  Were any steps added intentionally to complete or correct another step? Place checkmarks
against the steps as they are/were executed to avoid this. If steps had to be added on the fly in
order to proceed, record why and where.

After asking the questions, complete the following steps to resolve the issue:

•  Decide on one cause and possible solution at a time. Make appropriate modifications and then
test those modifications. Try to minimize the number of things you change between tests.

•  Test each modification to see if it fixed the problem.

•  Write down all symptoms, causes, and solutions. Having a written record makes an excellent
reference for future troubleshooting.

•  Install a new copy of the OS into a different directory. Does the problem still occur?

Compaq Partition Access
If you install LILO to the master boot record, you cannot access the Compaq system partition
using the F10 key. In order to be able to access the Compaq partition, parameters must be added
to the LILO configuration file. This can be accomplished from the menu in the GUI or through
the initial boot screen.
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GUI Method

From the Menu,

•  Select System → linuxconf → LILO Other OS Configuration.

•  Select the Other Operating System Setup tab.

•  The screen displays two boxes, one for the label and one for the partition name.

•  Type the label name in the appropriate box.

•  Type the identification of the partition in the correct box.

The partition identification refers to the number given by Linux during the formatting portion of
the installation.

•  Select Accept.

The system restarts.

•  Type in your label at the LILO Boot prompt.

Note:  Pressing Tab at the LILO Boot prompt will provide a list of partition labels that can then
be typed at the prompt.

Command Prompt Method

UNIX users might prefer to type the configuration information directly to the LILO.conf file in a
UNIX text editor. After login,

•  Type cd /etc and press Enter.

•  Select a UNIX text editor to alter lilo.conf and press Enter.

•  Add this line to the file:

other = <your partition number as determined from the formatting portion of the
installation>

label = <your label name>

Example:
# begin global section
boot=/dev/sda
map=/boot/map
install=/boot/boot.b
prompt
timeout=50
# begin Linux section
image=/boot/vmlinuz-2.2.12.6

label=linux
append="mem=128M" # allow access for greater than 64MB RAM
root=/dev/sda2
initrd=/boot/initrd-2.2.12-0.6.img
read-only
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# begin System Partition section
other=/dev/sda3

label=F10
table=/dev/sda

•  Run /sbin/lilo.

•  Restart the system to access the system partition.

•  Type in your label at the LILO Boot prompt.

SMART Array Controllers
The Compaq SMART Array controllers require some special handling to operate with Linux. The
2.2.x kernel tree can only detect devices on PCI bus 0. SMART Array Controllers are not on PCI
bus 0. Compaq developed a fix for this and it should be included with the next kernel version.
Until then, you can download the fix from SoftPaq 10775 (DOS version) or SoftPaq 10776
(UNIX version).

Configuring SMART Array Controllers

To set up the SMART Array controllers using SmartStart, follow this procedure:

•  Select UnixWare 2.1.3 as the operating system.

Note:  Some issues occur with the interrupt settings if another operating system is selected.

When exiting the System Configuration utility, SmartStart will automatically invoke the Compaq
Array Configuration Utility after the initial setup.

•  Follow the instructions included in the utility to build a RAID-0, RAID-1, RAID-4, or RAID-
5 array set and to create logical drives as desired.

•  Save the configuration with the wizard button.

Note:  Alternatively, select File → Save in the Array Configuration Utility and exit from the
utility.

•  Reboot the server to configure the hardware and install the system partition.

When completed, you will be prompted to save the configuration and reboot, or to view or edit
details. If you plan to boot from a SMART Array controller, complete the following.

•  Select View or Edit Details and scroll down to where the array controller appears in the
hardware list.

•  Verify that the array controller�s boot order is set as first.

A problem can arise if there are no bootable SCSI devices attached to one of the SCSI controllers
on the Compaq server. Even if a bootable partition exists connected to the array controller,
bootstrapping dies if the SCSI controllers are set to boot before being connected to a bootable
device (such as a disk drive).

http://www.compaq.com/support/files/server/us/index.html
http://www.compaq.com/support/files/server/us/index.html
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Partitioning SMART Array Controllers

Linux only sees one large disk drive with the SMART Array controller and displays the following
message when you partition your hard drive:

The number of cylinders of this disk is set to xxxx, there is nothing wrong

 with that, but this is larger than 1024, and could in certain setups cause

 problems with:

1) software that runs at boot time (e.g. LILO)

2) booting and partitioning software from other OSs (e.g. DOS fdisk, OS/2 fdisk)

This warning message reminds you to create your boot partition under cylinder 1023. Failure to
do so prevents your system from restarting after the installation.
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Appendix A–Hardware Specifications
The tables in this section provide information regarding standard specifications for servers
shipped by Compaq. The servers are divided into three groups�entry-level,
workgroup/departmental, and enterprise.

Entry level servers (Table 2):

� ProLiant 400

� Prosignia Server 720

� Prosignia Server 740

� ProSignia 200
Table 2.  Entry-level server specifications

 ProLiant 400 Prosignia Server 720 Prosignia Server 740 ProSignia 200

Processor
Speeds

Intel Pentium III 500,
550, and 600MHz

Pentium II 350, 400,
and 450MHz

Pentium III 500 and
600MHz

Pentium II 350, 400,
and 450MHz

Pentium III 500, 550,
and 600MHz

Pentium II 350, 400,
and 450MHz

Pentium II 350, 400,
and 450MHz

SMP Support No No No No

L2 Cache 512KB 512KB 512KB 512KB

Maximum
Memory

Pentium III 768MB

Pentium II 384MB

Pentium III 768MB

Pentium II 384MB

1GB 384MB

Disk
Controller

Integrated Wide-Ultra2
SCSI

Integrated Wide-Ultra2
SCSI

Integrated Wide-Ultra
SCSI-3

Wide Ultra SCSI -3

Disk
Controller
Chipset

Symbios Logic 53C876 Symbios Logic 53C895 Symbios Logic 53C876 Symbios Logic 53C875J

Tape Drives
Supported

DAT, SLR, DDS-3, DLT DAT, SLR DAT, SLR DAT, SLR

NIC Integrated Compaq
Netelligent 10/100 TX
PCI Intel UTP Controller
(Intel 82558)

Integrated Netelligent
10/100 TX PCI Intel
UTP Controller
(Intel 82558)

Integrated Netelligent
10/100 TX PCI UTP
Controller
(ThunderLAN)

Integrated Netelligent
10-T PCI UTP
Controller
(ThunderLAN)

Video 1024KB, 1024x768
pixel resolution at 256
colors

1024KB, 1024x768
pixel resolution at 256
colors

1024KB, 1024x768
pixel resolution at 256
colors

1024KB, 1024 x 768
pixel resolution at 256
colors

Video Card ATI Rage IIC ATI Rage IIC ATI Rage IIC CL-5446
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Workgroup/Departmental Servers (Table 3):

� ProLiant 800

� ProLiant 1600, 1600R

� ProLiant 1850R

� ProLiant 3000, 3000R
Table 3.  Workgroup/Departmental server specifications

 ProLiant 800 ProLiant 1600, 1600R ProLiant 1850R ProLiant 3000, 3000R

Processor
Speeds

Pentium III 500, 550,
and 600MHz

Pentium II  350e, 400,
and 450MHz

Pentium III 500, 550,
and 600MHz

Pentium II 350, 400,
and 450MHz

Pentium III 500, 550,
and 600MHz

Pentium II 400 and
450MHz

Pentium III 500, 550,
and 600MHz

Pentium II 300, 333,
400, and 450MHz

SMP Support 2P 2P 2P 2P

L2 Cache 512KB 512KB 512KB 512KB

Maximum
Memory

1GB 1GB 1GB 6/300 512MB

6/333 3GB

6/400 – 6/600 4GB

Disk
Controller

Integrated Dual Wide-
Ultra SCSI-3

Integrated Dual
Channel Wide-Ultra
SCSI-3

Integrated Dual
Channel Wide-Ultra
SCSI-3

Integrated Dual
Channel Wide-Ultra
SCSI-3

Smart Array 3200
Controller

Disk
Controller
Chipset

Symbios Logic 53C876 Symbios Logic 53C876 Symbios Logic 53C876 Symbios Logic 53C875J

(Integrated Controller)

Tape Drives
Supported

DAT, SLR, DDS-3, DLT DAT, SLR, DDS-3, DLT,
AIT

DAT, SLR, DDS-3, DLT,
AIT

DAT, SLR, DDS-3, DLT

NIC Integrated Netelligent
10/100 TX UTP
Controller

(ThunderLAN)

Integrated Netelligent
10/100 TX UTP
Controller

(ThunderLAN)

Integrated Netelligent
10/100 TX UTP
Controller

(ThunderLAN)

10/100 TX PCI UTP
Controller
(Intel 82558)

Netelligent 10/100 TX
PCI UTP
(450 and below)
(ThunderLAN)

Video 1024KB, 1024x768
pixel resolution at 256
colors

1024KB, 1024x768
pixel resolution at 256
colors

1024KB, 1024x768
pixel resolution at 256
colors

1024KB, 1024x768
pixel resolution at 256
colors

Video Card ATI Rage IIC Cirrus Logic
CL-5446B

ATI Rage IIC ATI Rage II
(400 and above)

Cirrus Logic
CL-54M30
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Enterprise servers (Table 4):

� ProLiant 5500

� ProLiant 6000

� ProLiant 6400R

� ProLiant 6500
Table 4.  Enterprise server specifications

 ProLiant 5500 ProLiant 6000 ProLiant 6400R ProLiant 6500

Processor
Speeds

Pentium III Xeon 500
and 550MHz

 Pentium II Xeon
450MHz

Pentium III Xeon
500MHz

 Pentium II Xeon 400
and 450MHz

Pentium III Xeon
500MHz

Pentium III Xeon
500MHz

 Pentium II Xeon 400
and 450MHz

SMP Support  4P  4P 4P  4P

L2 Cache  512KB, 1MB, 2MB  512KB, 1MB  512KB, 1MB, 2MB  512KB, 1MB, 2MB

Maximum
Memory

 4GB  8GB  4GB  4GB

Disk
Controller

 Integrated Dual
Channel Wide-Ultra
SCSI-3

 Wide Ultra2 Dual
Channel SCSI
Controller in a PCI Slot
 (Pentium III Models
w/LVD cages only)

 Integrated Dual
Channel Wide-Ultra
SCSI-3

 Compaq Smart Array
3100ES Controller

 Integrated Dual
Channel Wide-Ultra
SCSI-3 Controller

 Integrated Dual
Channel Wide-Ultra
SCSI-3 Controller

Disk
Controller
Chipset

 Symbios Logic 53C867

(Integrated Controller)

Symbios 53C879

 Symbios Logic
53C875J

(Integrated Controller)

 Symbios 53C876  Symbios 53C876

Tape Drives
Supported

 DAT, SLR, DDS-3,
DLT, AIT

 DAT, SLR, DDS-3,
DLT, AIT

 DAT, SLR, DDS-3,
DLT, AIT

 DAT, SLR, DDS-3,
DLT, AIT

NIC  Netelligent 10/100 TX
PCI UTP

(Intel 82558)

 Dual-Port Netelligent
10/100 TX PCI UTP
Controller
(ThunderLAN)

 NC3131 64 Dual Port
10/100 (Intel 82558)

 NC3131 64 Dual Port
10/100
(Intel 82558)

 NC3122 64 Dual Port
10/100
(Intel 82558)

Video  1024KB, 1024x768
pixel resolution at 256
colors

 2MB, 1024x768 pixel
resolution at 256 colors

 2MB, 1024x768 pixel
resolution at 256 colors

 2MB, 1024x768 pixel
resolution at 256 colors

Video Card  ATI Rage IIC  ATI Rage IIC

Cirrus Logic
CL-54C46

 ATI Rage IIC  ATI Rage IIC
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Additional enterprise servers (Table 4a):

� ProLiant 7000

� ProLiant 8000

� ProLiant 8500
Table 4a.  Additional enterprise server specifications

 ProLiant 7000 ProLiant 8000 ProLiant 8500

Processor
Speeds

 Pentium III Xeon
500MHz

 Pentium II Xeon
450MHz

 Pentium III Xeon
550MHz

 Pentium III Xeon
550MHz

SMP Support  8P  8P  8P

L2 Cache  512KB, 1MB, 2MB  512KB, 1MB, 2MB  512KB, 1MB, 2MB

Maximum
Memory

 8GB  8GB  8GB

Disk
Controller

 Integrated Dual
Channel   Wide- Ultra
SCSI-3

 Smart Array 4250ES  Integrated Wide Ultra2
SCSI Dual Channel
SmartArray Controller

Disk
Controller
Chipset

 Symbios Logic
53C875J

Tape Drives
Supported

 DAT, SLR, DDS-3,
DLT, AIT

 DAT, SLR, DDS-3,
DLT, AIT

 DAT, SLR, DDS-3,
DLT, AIT

NIC  NC3131 64 Dual Port
10/100 (Intel 82558)

 NC3131 64 Dual Port
10/100 (Intel 82558)

 NC3131 64 Dual Port
10/100 (Intel 82558)

Video  2MB, 1024x768 pixel
resolution at 256 colors

 2MB, 1024x768 pixel
resolution at 256 colors

 2MB, 1024x768 pixel
resolution at 256 colors
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Appendix B—Compaq Monitors
Table 5 provides information for manually configuring your Compaq monitor for Linux.
Table 5.  Compaq monitor specifications

Monitor
Horizontal

Frequency

Vertical

Frequency
Monitor

Horizontal

Frequency

Vertical

Frequency

14” Monitors 19” Monitors

1024 30 - 60 kHz 50 - 100 Hz P900 30 – 107 kHz 50 – 120 Hz

140 31 – 48 kHz 50 – 100 Hz S900 30 – 95 kHz 50 – 160 Hz

V40 31 – 48.4 kHz 50 – 100 Hz V90 30 – 94 kHz 48 – 160 Hz

V45 31 – 50 kHz 50 – 100 Hz V900 30 – 96 kHz 48 – 160 Hz

SVGA 31.5 – 38 kHz 43 – 60 Hz

15” Monitors 21” Monitors

150 31 – 48 kHz 50 – 100 Hz P110 30 - 107 kHz 48 - 160 Hz

151FS 30 - 60 kHz 50 - 100 Hz P1100 30 - 121 kHz 50 - 160 Hz

P50 30 - 69 kHz 47.5 - 125 Hz P1610 30 - 96 kHz 48 - 160 Hz

V50 31 - 60 kHz 47.5 - 115 Hz V1000 30 – 107 kHz 50 – 160 Hz

V55 30 – 60 kHz 47.5 – 125 Hz QVISION 200 30 - 82 kHz 50 - 160 Hz

V500 30 – 70 kHz 50 – 160 Hz QVISION 210 31 - 94 kHz 48 - 110 Hz

S500 30 – 54 kHz 50 – 120 Hz

QVISION 150 31.5 – 58 kHz 50 – 100 Hz

17” Monitors TFT Display

171FS COLOR 30 - 60 kHz 50 - 100 Hz TFT450 31.5 – 60.2 kHz 59 – 85 Hz

QVISION 170 31.5 – 58 kHz 50 - 100 Hz TFT450R 31.5 – 60 kHz 56.3 – 85 Hz

QVISION 172 31.5 – 82 kHz 50 – 110 Hz TFT500 31.5 – 60.2 kHz 59 – 85 Hz

S700 30 – 69 kHz 50 – 160 Hz TFT5000 31.5 – 60.2 kHz 56 – 78.75 Hz

P70 30 - 92 kHz 50 - 150 Hz TFT5000s 32 – 60 kHz 57 – 85 Hz

P75 30 - 85 kHz 50 - 150 Hz TFT5000r 31.47 – 60 kHz 57 – 85 Hz

P700 30 – 92 kHz 50 – 120 Hz TFT8000 31.5 – 80kHz 60 – 85 Hz

V70 30 - 69 kHz 60 - 125 Hz

V75 30 - 69 kHz 47.5 - 125 Hz

V700 30 – 85 kHz 50 – 160 Hz
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Appendix C–Compaq SoftPaqs for Red Hat
Linux 6.1

The Compaq SoftPaq for Red Hat Linux 6.1 can be downloaded in DOS or UNIX versions. Both
SoftPaq 10775 (SP10775), the DOS version, and SoftPaq 10776 (SP10776), the UNIX version,
require the creation of diskettes before proceeding with the Red Hat Installation. The SoftPaqs
provide device driver workarounds for the SMART Array Controller and the Compaq NC3131
DualPort NIC.

Appendix D–Compaq Information Products
In addition to hardware and software products, Compaq also provides information enabling you
to stay current on the latest developments and assisting you in making deployment decisions.

Compaq ActiveAnswersTM gives you the benefit of our experience to help manage your system
and reduce the time, risks, and complexity associated with deploying solutions.

If you require more timely access to information products, Compaq provides a service called
Compaq Info Messenger, which can be accessed through the Compaq website. If you submit a
profile to Compaq Info Messenger, telling it what platforms and operating systems you are
interested in, the service tracks your areas of interest and advises you when related information
products are released.

Customer Advisories inform you of any known problems and workarounds because of a Service
Pack release.

Communiqués and press releases announce the availability of new products and versions.

Service Advisories notify Compaq resellers and retailers of any known service-related issues and
provide them with the information they need to effectively support their customers.

Solution Stories describe how Compaq customers have addressed their business needs through
the combination of Compaq products and third-party software products.

TechNotes and Tech Briefs update customers on the latest developments in Compaq products.

White papers inform you of ways to optimize your environment and obtain the maximum benefit
from software enhancements.

These information products range from those with no specific OS focus to those that address
specific OS issues and answers. Table 6 lists Compaq resources.

http://www.compaq.com/support/files/server/us/index.html
http://www.compaq.com/support/files/server/us/index.html
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Table 6.  Compaq web resources

Item Web Location

Compaq ActiveAnswers http://www.compaq.com/activeanswers

Compaq Info Messenger http://www.compaq.com/infomessenger

Compaq Insight Manager http://www.compaq.com/sysmanage

Compaq Management CD http://www.compaq.com/support/files/server/us/index.html

Compaq Option ROMPaq http://www.compaq.com/support/files/server/us/index.html

Compaq SmartStart Subscription
Service

http://www.compaq.com/products/servers/smartstart/index.html

Compaq Survey Utility http://www.compaq.com/support/files/server/us/index.html

Compaq System ROMPaq http://www.compaq.com/support/files/server/us/index.html

Customer Advisories http://www.compaq.com/support/techpubs/Customer_advisories/index.html

Press releases http://www.compaq.com/newsroom/pr

SoftPaqs (complete listing) http://www.compaq.com/support/files/allsp.html

 White Papers and other technical
document (complete listing)

http://www.compaq.com/support/techpubs/whitepapers/index.html

Information specific to Linux and Red Hat can be found at the locations listed in Table 7.
Table 7.  Linux and Red Hat resources on the web

Item Location

Red Hat “How To” site http://www.redhat.com/support/docs/howto

Red Hat certified hardware http://www.redhat.com/support/hardware

Red Hat manuals http://www.redhat.com/support/manuals

Red Hat news http://www.redhat.com/about/press_releases.html

Red Hat errata http://www.redhat.com/support/errata

Linux kernel information http://www.kernelnotes.org

http://www.compaq.com/activeanswers
http://www.compaq.com/infomessenger
http://www.compaq.com/sysmanage
http://www.compaq.com/support/files/server/us/index.html
http://www.compaq.com/support/files/server/us/index.html
http://www.compaq.com/products/servers/smartstart/index.html
http://www.compaq.com/support/files/server/us/index.html
http://www.compaq.com/support/files/server/us/index.html
http://www.compaq.com/support/techpubs/Customer_advisories/index.html
http://www.compaq.com/newsroom/pr
http://www.compaq.com/support/files/allsp.html
http://www.compaq.com/support/techpubs/whitepapers/index.html
http://www.redhat.com/support/docs/howto
http://www.redhat.com/support/hardware
http://www.redhat.com/support/manuals
http://www.redhat.com/about/press_releases.html
http://www.redhat.com/support/errata
http://www.kernelnotes.org/
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